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Overview

WindowsEmbedded Standard 7 (WES7) provides the ability to create a customized embed-
ded form ofWindows that includes only those components that are needed by the target sys-
tem.

Earlier versions ofWindowsEmbedded provided amore granular configuration process that
required all components of the operating system to be selected before an image could be
built. This process allowed IntervalZero to provide RTX Runtime components that could be
directly added to a target image.WithWindowsEmbedded Standard 7, Microsoft simplified
the target creation process by changing the way that individual components are selected. As
a result, RTX Runtime components can no longer be directly added to a target build. Instead,
new functionality is available to automatically perform a silent install of RTX Runtime as
WES7 is being installed onto the target system.

WithWindowsEmbedded Standard 7, there are two ways to build an image:

l The Express Path uses the Image Builder Wizard (IBW) to build an image based on
the answers to basic configuration questions.

l The Advanced Path uses the Image Configuration Editor (ICE) to create an answer
file that defines the functionality, software and settings that are needed in the image.
This is themost flexible way to create an image and provides the ability to perform an
unattended installation ofWES7.

ThisMiniTutorial will focus on the advanced path and walk you through the steps necessary
to create aWindowsEmbedded Standard 7 image that includes the RTX Runtime.

More information onWindowsEmbedded Standard 7 can be found by looking at the links
provided in theResources section at the end of this document.

WES7 Image Creation Steps
Creating an image that includes the RTX Runtime requires the following steps:

l Install theWindowsEmbedded Standard 7 Toolkit.

l Start the Image Configuration Editor.

l Create an Answer File (AF).

l Select a Distribution Share (DS).

l Add the RTX Silent Installer to the Distribution Share.

l Add the RTX installation command to the Answer File.

l Add Additional Components to the Image.
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l Analyze Installation Kit Dependencies.

l Validate the Answer File.

l Create Image Files.

l Create a Bootable Device.

l Add Image Files to the Device.

l Boot theWES7 Install on the Target System

l Customize the Image.

Install Windows Embedded Standard 7 Toolkit

The instructions in thisMiniTutorial assume that theWindowsEmbedded Standard 7 Toolkit
has already been installed. For information on obtaining the software, visit theMicrosoft web
page:

Windows Embedded Standard

Installation instructions can be found on theMSDN website at:

Install Windows Embedded Standard 7 Toolkit on a Development Computer

Create Image Using ICE

The Image Configuration Editor (ICE) allows you to create an answer file that will define the
components and settings for your target installation.

Start the Image Configuration Editor
Once theWindowsEmbedded Standard 7 Toolkit has been installed, start the Image Con-
figuration Editor from the Start menu by selecting:

Windows Embedded Standard 7 > Image Configuration Editor
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Create an Answer File
To create a new answer file

From the Filemenu, selectNew Answer File.

Note: The new answer file has a default name of Untitled. To name the file,
save the answer file by selecting Save Answer File from the File menu. For now,
ignore validation errors as theywill be corrected later.

Select a Distribution Share
All components that will be used to build the image are stored in a distribution share (DS)
folder. Using a shared folder allows the same source to be used to createmultiple images.
Preconfigured, default distribution shares include:

l C:\ProgramFiles\WindowsEmbedded Standard 7\DS

For a 32-bit distribution built on a 32-bit development computer

l C:\ProgramFiles\WindowsEmbedded Standard 7\DS64

For a 64-bit distribution share built on a 32-bit development computer

Since IntervalZero RTX Runtime supports only the 32-bit version ofWES7, to ensure you
have the correct distribution share:

1. Right-click the directory specification under the Distribution Share heading.

2. Click Select Distribution Share from the pop-upmenu.

3. Browse to and then double-click:

C:\Program Files\Windows Embedded Standard 7\DS

Note: This assumes thatWindowsEmbedded Standard 7 was installed in the
default directory.

Add the RTX Silent Installer to the Distribution Share
The distribution share should contain all components needed to build the image. To include
the RTX Silent Installer in the image, it must be added to a subdirectory of the distribution
share. To do this:

1. Right-click the directory name at the top of the Distribution Share tree.

2. Select Explore Distribution Share... from the pop-upmenu.

3. When an explorer window pops up:
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a. Browse to (or create, if it does not exist) the following subdirectory in the dis-
tribution share directory tree.

<DS>\$OEM$ Folders\Custom Files\$OEM$\$1

Where the default value of <DS> is C:\Program Files\Windows Embed-
ded Standard 7\DS.

b. Copy the RTX Runtime Silent installer (IntervalZero RTX 2011.msi) to
this subdirectory

Note: The \$OEM$\$1 directory represents the root of the drive onto which you
will installWindowsEmbedded Standard 7.

To ensure files in this $OEM$ directory are included in your image:

1. In the Distribution Share pane in ICE, expand the $OEM$ Folders node.

2. Right-click the Custom Files folder, and click Insert Oem Folders Path

3. Browse to <DS>\$OEM$ Folders\Custom Files\$OEM$

For more information, refer to theMSDN article:

Add Custom Files and Folders Using Image Configuration Editor

Add the RTX Installation Command to the Answer File
ICE allows the developer to add custom commands to the answer file. To perform a silent
installation of the RTX Runtime, check theSilent Installation Guide for RTX 2011 for the cor-
rect format of the installation command. Then, add it to the answer file as follows:

1. Right-click the Answer File (name, or Untitled if it has not yet been saved).

2. In the pop-upmenu, click Insert Synchronous Command to Pass 7 oobeSystem.

3. Enter the RTX Runtime silent installation command using the full directory path (refer
to the Silent Installation Guide for command format and options).

4. Once the full directory path and command have been entered clickOK.

As noted above, since the RTX Silent Installer file was copied to the \$OEM$\$1 sub-
directory, it will be placed into the root of theWES7 target. In that case, your directory
path should use C:\, as in the example below:

"C:\IntervalZero RTX 2011.msi" /qn
OPTIONS="LICENSE=12345-12345-12345-12345-12345;
TARGETDIR=c:\Program Files\IntervalZero\RTX;
SM_ICONS;MANAGED;NO_RTXUAC;RTXUSB;RTTCPIP"

This command should be all on one line and include a valid license number. The eas-
iest way to do this is to enter the command into a text editor. After checking for syntax
and license number correctness, cut and paste into the ICE command line prompt.
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Notes:

After the command has been added, you can see it by browsing the Answer File
pane to Product\Operating System\Foundation Core\Windows
Embedded Edition\Shell-Setup_x86 and then look for CommandLine
under the FirstLogonCommands in the Settings pane.

Add Additional Components to the Image
A newWES7 answer file begins with theWindowsEmbedded Edition Foundation Core com-
ponent. Additional components are selected by the user. RTX requires both theWindows
Installer and the Device Driver Frameworks.

For the RTX silent install command to work, theWindows installer must be included in the
image. Add theWindows Installer component as follows:

1. Expand the Distribution Share to locate

Packages > FeaturePack > System Services > Windows Installer

2. Right-clickWindows Installer

3. From the pop-upmenu, click Add to Answer File

For the RTX Subsystem to start, the Driver Frameworksmust be included in the image. Add
the Driver Frameworks component as follows:

1. Expand the Distribution Share to locate

Packages > FeaturePack > Devices and Printers > Driver Frameworks

2. Right-click Driver Frameworks

3. From the pop-upmenu, click Add to Answer File

If the RTX installation option TOOLS was used, theWindowsApplication Compatibility fea-
ture packmust be included:

1. Expand the Distribution Share to locate

Packages > FeaturePack > Management

2. Right-clickWindows Application Compatibility

3. From the pop-upmenu, click Add to Answer File

Additional components can be added either by selecting them individually, or by including a
template that contains a common group of features. TheWES7 kit provides the ability to use
one of several predefined templates. To view and select one of these, do the following:

1. Expand the Distribution Share to locate Templates > IBW.

2. Right-click a template.
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3. Select Add to Answer File from the pop-upmenu.

Note: Once you have selected each of the components that you want to include,
you can save your own template to be used as an initial starting point for future
image builds.

Analyze Installation Kit Dependencies
The Image Configuration Editor provides a tool to analyze a silent installer file and determine
what components it depends upon. Analyze the RTX Runtime installation file as follows:

1. From the Tools pull-downmenu, select Analyze Static Dependencies.

2. Browse to the IntervalZero RTX 2011.msi file that was added to your
selected distribution share.

3. A pop-up status window will appear while static dependencies are being analyzed.

4. In the Analyze Static Dependencieswindow

l Select Required Packages.

l Enter a name for the file subfolder (such as RtxDependencies).

l ClickOK.

The selected components will now be in the Answer File.

Validate the Answer File
The new answer file will include theWindowsEmbedded Edition Foundation Core and any
additional components you have added. Some of the components that were added will have
required dependencies and others will allow you to select from a group of optional depend-
encies. To ensure that all required and optional dependencies are included,

1. From the Validatemenu, select Validate Only.

2. In theMessages Pane at the bottom of the window, double-click each validation
description and select optional and required components from the Resolve Depend-
encies window.

Repeat the steps above until nomore validation errors are displayed.

Reminder: After making any changes to the answer file (such as adding com-
ponents or importing a template) you should repeat the validation steps to ensure
any dependencies are satisfied and then save the answer file using File > Save
Answer File.
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Create Image Files
Once all selections have beenmade and the Answer File has been saved, create image files
that will be copied to a bootable device. Create theWindows Image Builder Wizard (IBW)
files using:

Tools > Create Media > Create IBW Image from Answer File

Select a directory location to store the IBW image files. Remember this directory location, as
it will be needed when the image is put onto a bootable device. For example,
C:\temp\IBW_wRTX_Image.

Optional installation procedure: ThisMiniTutorial walks you through the steps
needed configure a single device that will boot and then automatically begin setup
of theWES7 install. It is also possible to installWES7 after booting from a light-
weight or preinstallation environment (PE) version ofWindows. To do that, see
the section titled Installing FromPE Image at the end of this document.

Once the image has been saved, you can exit the Image Configuration Editor.

Put Image Files onto a Bootable Device

To install the newWindowsEmbedded Standard 7 onto your target, youmust first create a
bootable device. The steps needed to create bootablemedia that will automatically run
Setup from the IBW image are listed below.

1. Create a bootable device (USB flash drive, CD-ROMdisk or other bootablemedia).

2. Copy all files from the IBW image directory to the bootable device.

3. Boot the target system from the newly configured device and setup of the IBW image
files will automatically begin .

Instructions for creating a bootable USB Flash Drive (UFD) and for creating a bootable CD-
ROMare given below. Select one of these, or read the followingMSDN article for help with
other device options:

Image Builder Wizard – Quick and Easy Embedded OS Creation

Note: Instructions are given for creating a bootable UFD and for creating a bootable CD-
ROM. Other media that can be booted on your system can also be used. Only onemedia
type needs to be selected and created.
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Create a Bootable UFD with IBW Image Files
To create a bootable USB Flash Drive (UFD) open a command prompt with Administrator
privileges and use the diskpart utility as shown below. These instructions can also be found
in theMSDN article titledCreate a Bootable Utility UFD.

Note: The diskpart utility inWindowsXP does not show removable storage in a
disk list. So, this step should be performed using aWindowsVista or Windows 7
system.

do the following:

1. Start the disk partition tool:

diskpart

2. Determine your disk number:

list disk

3. Select your device

select disk <disk_number>

4. Remove partition and volume information

clean

5. Create a primary partition

create partition primary

6. Set focus to the newly created primary partition

select partition 1

7. Mark the partition with focus as a valid system partition

active

8. Format the partition

format FS=ntfs LABEL=<Label> QUICK

9. Assign a drive letter to the partition

assign

or

assign LETTER=<L>

10. Exit the diskpart utility

exit
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Copy all files from the IBW image directory to the bootable UFD using the following com-
mand:

xcopy C:\temp\IBW_wRTX_Image\*.* /s /e /f L:\

where C:\temp\IBW_wRTX_Image is your IBW image file directory and L:\ is your UFD
drive letter.

Create a Bootable CD-ROM with IBW Image Files
To create a bootable CD-ROMwith IBW image directory files, youmust first create an ISO
that contains a bootable image of the IBW directory as follows:

1. From the Start menu on the development computer, select

All Programs > Windows Embedded Standard 7 >

Windows PE Tools Command Prompt

AWindowsPE Tools Command Prompt window opens.

2. At theWindowsPE Tools command prompt, use the Oscdimg tool to create an ISO
file that has the contents of the image directory you created, using the ETFS-
BOOT.COMcommand located in the BOOT subdirectory. For example, if your image
directory is C:\temp\IBW_wRTX_Image and you want to create your ISO in
C:\temp\, called IBW_wRTX.iso type the following:

oscdimg -n -bc:\temp\IBW_wRTX_Image\BOOT\ETFSBOOT.COM C:\temp\IBW_wRTX_Image

C:\temp\IBW_wRTX.iso

Where parameters to oscdimg are:

-n allow long names

-blocation - Location of boot sector file (no space after the "b")

Location of image source files

Location of target ISO file

TheOscdimg command above will create a bootable ISO file named IBW_wRTX.iso in the
c:\temp\ folder.

Using CD-ROMburning software, burn the ISO file to a blankCD-ROM.

For more information, refer to theMSDN article:

Create and burn the ISO file to a CD-ROM
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Boot the WES7 Install on the Target System

The Image Configuration Editor allows you to create an answer file that includes the com-
ponents and settings for an image that will be installed onto your target system.

Note:When the image created by thisMiniTutorial is installed onto the target sys-
tem, you will be prompted for basic settings. To configure an answer file to be fully
unattended, see the Resources section at the end of this document.

Before booting your image, check that the systemBIOS is set to ensure that the boot order
includes the device that you have built your IBW image onto.

After inserting your boot media, the following should occur:

l Messageswill display indicating:

n Windows is loading files

n StartingWindows

n Setup is Starting

l License agreement will be displayed. Read and accept terms and click Next.

l Language preferenceswill be displayed. Select and click Next.

l Available disks will be displayed.

n Select the disk for the target installation.

n To format the disk, expand drive options and select Format.

n To use the selected disk click Next.

l Windows installationmessageswill appear including:

n CopyingWindows files

n ExpandingWindows files

n Installing features and updates

The systemwill reboot to apply system settings. When the system comes back up, theWin-
dowsBoot Manager will includeWindows Embedded Standard as a new boot option.

Note: If using a bootable UFD, remove it after system files have been copied, and before a
reboot occurs.
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Customize the Image

The first time you start your image, the following setup prompts will appear.

l Username and Computer name

l An optional user password

l Product key

Customization will continue after selecting one of the following:

l User recommended settings

l Install important updates only

l Askme later

The last prompt will be for time and date settings.

After screens forWelcome andPreparing your desktop the RTX Runtime installation will
occur.

n AWindowsSecurity pop-up window will confirm the installation IntervalZero software.
Click Install to continue.

n A warning that setup was unable to interface with the power management service
may appear. Since RTX does not use Power Management services, this warning can
be ignored. ClickOK to continue.

After the installation of RTX, youmust reboot your system for the RTX Runtime installation
to complete.

Important: To confirm that the system has been rebooted after the installation of RTX, go to
the Control tab of the RTX Properties control panel. If status is Undetermined, the system
needs to be rebooted. If status is Stopped you can start the subsystem by clicking the Start
button.

Tomake custom changes to theWindows Image (.wim) file of a target system that has been
installed and is running, use the Deployment Image Servicing andManagement (DISM) tool.
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Installing From PE Image

ThisMiniTutorial walks you through the steps needed to configure a single device that will
boot and then automatically begin setup of theWES7 installation. It is also possible to install
WES7 after booting from a lightweight, or preinstallation environment (PE) version ofWin-
dows. To do this, follow the steps below.

If you do not already have a bootable PE device, do the following:

1. Create a PE image from ICE using:

Tools > Create Media > Create Windows PE Image

Select a directory location to store the PE image files, such as C:\temp\PE_
Image\

2. Create a bootable device (USB flash drive, CD-ROMdisk, etc.).

3. Copy all files from the PE image directory to the bootable device.

4. Boot from the bootable device containing PE image files.

To perform the install:

1. Copy all files from the customized IBW image to other media or to the target machine.

2. After the PE system has booted, run Setup from the IBW image files.
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Resources

For more information, see the following documents:

l Windows Embedded Standard: Product Overview

l Windows Embedded Standard 7 Technical Overview

l Windows Embedded Standard 7 on-line documentation

l WES7 documentation section on Building Images

l Windows Embedded Standard White Papers link to Architectural Comparison of
Windows Embedded Standard 7 vs. Windows Embedded Standard 2009

l Configure an Answer File to be Unattended
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